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Face Tracking Robot

By
Pruk Ninsook

Pavinee Ratanatanyong

Advisor
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ABSTRACT

This thesis presents the study and implementation procedures of a face tracking robot
using a web camera to reccive the video stream. The objective is to utilize the knowledge of
image processing and control system design for controlling the movement of the robot. First, the
theory of image processing and the face tracking programme algorithm have been studied.
Secondly, the design of controller is implemented via a microcontroller to control the 3
dimensional movement of the robot. Finally, the experiments were conducted to evaluate the
efficiency. The robot can be used to pin point the position of a face and moves as the face moves,
Thus. attention can be paid via computer toward a particular arca. Also, this can be used as a part

of' a security system,
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2.3.3 SalmunTu (Histogram)

ey 3 v

= < g ¥ d & - w o o
EiﬁIﬂLLﬂSHLﬂHﬂTiLEﬁﬂQl'I‘TL“riuﬂﬂﬂ'l'13Jﬂ‘llﬂ‘3ﬂ15uUTI']u'JuWﬂL°ﬂﬁ NUAIR NV UIADY

o

r é o ) ' o
Amian Tussduam unu « Tunsmlumussedudinm wozunu y unusidnauinealy

¥
[ o

TEAUTN U
jUssvesda launsuawnsovendnuazuralszmsveanwld wu §salaunsui

AHHENUALIZMUWDINIVIAANULANA NS E N TIRNNE Az A iR (Contrast) lunw

e

E:QE

"
=y o L 4 {
parlaunTudd s TomilumsAmuasefumsalen (Threshold) Sefidenisiiounin

srAudmIfidussuumugiuees (Binary) H3aifoUSuagaunsdiuvesmilng sy (Spectrum)

UDITTAVFIM

frequercy

Groy hevel

ar

1UT 2.6 BaTaunsuveaszdudim

2.3.4 madasszduaminemsvunsalsn (Threshold)
flumsudeuudamSemuuaTduuesdssdudimlunw eyt suuuuiaasy
‘ & o e = . e 4 4 &
(Diserete)  WINAU Tasshimmndda Taunsuudrdmuamissduminduouiuunite

] 3 a o & ! @ m o 'y
Wugadarunsalea smivezimsdansellauaduvesssdudmis luidesmseontyl

L
=

4 ' ° Y o 4 "
Fatlss Tomvoansalan 1dun msiidhin i luund waviasiumsonfioesimua

1wAnmsa leafdnqgaoonutld

2.4 Hug LAz szuuiveadluma

i d
=]

vndlandn 13ludiade 2.1 udrirgdam fle yednates gafithiniSvededu #iii

]
[

a ! ' o <4
Tnmuguwy Tasudaznuuiitsy lowilumstsznnaranmane fuld Sgiwuvedds

-1

»
nonIsiud 3 suuuy fil

o




24,1 RGD

iiuuduuy RGB Yizneu i@ wdndn 3 & o uee Mod uasiady Faguuuudil

wdilnssadraduitamsfFou (Cartesian Co-ordinate) Tﬂunvnanym%ﬂumagnmﬁn fien

fung T;TL‘UU'J uawﬁumuagwynmﬁmmﬂuunu Llﬂullﬁ'ﬂ'lﬂb"lll ﬁiJ'N GAGLN ﬂq‘l"lllllﬂﬂ

GRITTY ﬂ’mi]xilgﬂ?ﬂﬁ'uﬁﬂ Aadnadauiiu o Aedudd ’sTHJ‘I’JﬂﬂE)GI';'»i‘ﬁ"IlIﬂUﬁﬂ‘IBQm'Q

1
o o

yulnaninyaduilaiige 1u§ﬂuuuumsmﬂummnwagumﬁ’mvmwQﬂﬁmuawgﬂﬁﬁm

\ o d o
TrT’J'L!ﬁFJ‘L!‘] NILHA 1ﬂgﬂ1ﬂiuﬂﬂu1ﬁﬂu

Rl ! .G Cyan

While hlugenta
(200, 255.250)

L] Whie

mm L’ h”& seake [CARI

- —— e e oo

- tirgvn

.~

-
-

(AR e
Red Yehow

1 2.7 3uuvd RGB

»
= &4 a -] Y )
juvud RGB 4 lunilsfinimavydsznouldemd Fay & Tn somilu 24 5n fo

L= 1 1

v »
uAnzfrazliand 256 a1 WuRoguunesid1ét 16,777,216 & gUuvvFiusas deiiudaas
ADAU

2.4.2 HSV

jUuuud HsV exlsznouludonidr (Hue) Ao mistaseduvesd snususs

(Saturatlon) fo ﬂ'lﬂ'J'IiJEJIJﬂ'J‘UENﬁ ﬂ?ﬂ’J'IlJHJiJﬁiﬂﬂﬂlJﬁ?N‘Uﬂﬁﬁ (Value) ma’muxﬂuyu

=

SOLLAUR Sufaueaddvududimdes § #lien ARwnsw 3 ﬁumu #3099 wazMnFuIFuAg

e oo

» ' ]
AnususEa19n 0 1U8 1.0 Tasunud@doadu luszduvesmiuszifouamning il

[
o &Aoo

adusvesd Gedudmy WidAtanusuiuduf guamanuunsoa Nyaen

=h

L

LY a

! ' o = J
A1970 0 614 1.0 1vuny TﬂUﬂslﬁu';m’uui]:ummmmwmm

il

G




i0

Covitrie

U7 2.8 sUuuud Hsv

2,43 YChCr

uudnuy Yober axlszneulddien v uansemilSinuvewaslumsdes

¥

A9 (Luminance) LAZIZTAMMULANAINDITEDAT Cb LAAINIAINIULANA 19U DIR T
-y Qs 1 =Y r fé 1 t T ) (73 1 = 1 é
AUAUAD19B98 MITY waze Cr LRGN NAULANA YA AL UA BB S A M

= e Yo o 1 u o ¥ ao oo [V | ma
indildduiunsnawdmiundedda lefifinsufinnwiwuisaea

2.5 TaunFvealdsunsuiillumsszydumisdunha

5 1
oY ey

o ' av { 1 S aa
Tsunsulumsseyghumisiunthauil 1818900535850 h Tofudd (Opency)
T . 4 4 e T g 5
3950nIANT 31 Open Computer Vision Fullulavssilszneudefledududogsmoy
¥
nndmiumsldnudmszuunsueinmuoinouiuae (Computer Vision) HUge s

ANITZHNN (Image & Pattern Analysis) (a2 M15UI=LIARANMN {Image Processing) 1un19

»
=~y

#3139 Application q'szuqq Tatjuftonts emunuidonIng Real Time) Hundn Tausiiign
Fanniu TasySEmsuma éaﬁmmmmm‘sm%’umi”l«%’muuunuuﬂﬁﬂ'ﬁms (Operating
System) A UWATDIROTAADS IEDt M INMAN 19U Microsoft Windows 9X, Windows
NT, Window XP uaza 150 19iundss Webcam tielad g

Imﬁuc‘i‘ﬁmw%’auﬁu”la%'g"la (HighGUI H3e High Graphic User Interface) ﬁ‘l*ﬁﬁamﬁ
Sunmunadesdd Tosasmaadramimamenaasmanin wenINfam s AN MIAS
ﬁ'mﬁumw"lﬁwmu;ﬂuuu {Format) Y Bitmap, Sun Raster, JPEG, TIFF, Portable Network

Graphics (.png), Portabie image (.pbim, .pgm, .ppm) Hudn



11

251 ﬁaﬁ%’u‘lu‘lnmﬁmm‘imﬁu%’% (Functionality of OpenCV Library)
»

I d aaq @ s a oy W ' o a4 o ow
ﬂlwumﬂuﬁd‘ﬂuﬂﬁ‘m‘l‘iﬂﬂ1u3mﬂ1ﬁﬂmﬂﬁ1ﬁﬂ§Ulﬂll‘lﬂﬂ’ﬂ 350 ‘WQﬂG]fu 2NN

asanIzimanasn 1aondae Taveusou e 188l

2.5.1.1 MIIANZHAWN (Image Analysis) 31315091 181058 1wy

M3 un3% Taa (Thresholds)
d‘ ' a ; ? = J
HumsuSounlasmidmlunmier Ifdudanin (Discrete) 1ndumie
o 9/ of = o =) e [
Midlunmuurlund  @ndy  Taemnm@meesyalanlunmssmnn i
o J df =) Sy [
waslea sxhmsiladuiudun  wasmndidmvesyalanlunwistosniin

msylen wwihmsilaaaiius Swanslugi 2.

- Value and Threshold Level

Threshold Binary

3UN 2.9 mahmsaTea (Threshold)

MIATUIMNIIEDA (Statistics)

Wunsminnniige (Max) Yoofiqa (Min) A1ndo (Ave) iudu

mmfmﬂﬂﬁ (Morphology)

- - df a ¥ t
WumaiinlumsszuasonmlasRinsammziuiisdonms @y ms
W18159U (Erosion) nianisnadinguiinisa uazlomdu (Dilation) Mien1svenesa

1, d 3/
nauAna udu

Erosion Dilation

UM 2.10 A1wfRn9 N3 Erosion 1492 Dilation



12

4) AMIMIANHUE (Feature Detection)

I~ o ] []
HUMIMIANYUZANUOININ 1Y MSHIvDL (Edge) MU NFUASA
NS 1A (Contour)

319 211 MsmvevveInIN

2.5.1.2 Myzyiunsiaveaing (Object Recognition)

34
a

o 1 o o - & =] & 1
msszymuniavesiagin annseldszyinglan A18 wilsluFmaseydumis

a ] o

] 8  w d . a a
vosirghaemsiwdnduunindu (Back Subtraction) Tmemdnnissialufdeszdesldinis
Fd »
TuinswaziBoavesiagiuadedew vinfuSahinsdfvfveumngfinmavesnisdunm
& ! - w e W o S W 1 a ey oy
(Capture) 2 053 szwdnnmiigniunn I lunsuusnfunwfisuduniny Tnofneafias
= a

w dd a o v = Hea a w o aa =
lﬂU?ﬂuﬁlz‘Lji'Iﬂ;]NﬂﬂWﬁLﬂ‘HWﬂL‘ﬁﬂﬁﬁﬂ? muwm«uawnﬂmaﬂuﬁ]zﬂsmgmnnwmi‘luwmmaﬁ

b [
] @ =

o s R J oo o M o ' o q:«J
M TsusERINTuRunTIInRe Tagiiauls  msszydumiiavosiagdaeiiiion
a 3 ¥ ¥ 4 ! A ] = & o el ¥ = woa
hllldseylumbhauded ldusenianuianamnnmaduestundaiinm indfsesud
Hwaslunihnuun
v & o & w ¢ o oa Y N T
asumnlaghisasImsseszyazundaiudeluniiny mawnsaldsniiuieis
[ " ) " . .
Amgndsaiudunnnififendt samuanediTuna (Hidden Markov Model Algorithms:
& = yd = - o 1 a
HMM) #3933 ilunisifeuBuazuuuum (Patern) foududiussslumhiautugudeya
] »
v laguidvduma grudeyaildimsifususunvazBadndeqvosluntan
' Y o ] a o ¥ 4 1
wu a1 10 ayn A idudy Ml dSnvas Tnssadevess Soaziequulunsfuluey
u: @ J a = e A = o ' 3
TivufuFvesiundunitenTsusn unziedumsiivanmuslumsyszainanadusieg
] ¥
Tl Emsmvevvesnwiwanslugilf 2.2 sde Fmsaeei s aunsousnues 12
1 1 1 t a J la Q = s :
handadudmdszneuvsalumhauldgndsmaziniuéminiularhisin g snfuly
- n.: o a ] J ‘ = | Y op owoa s o d aa
naszylunimmiufmusod 8oty feudldnguirdsfioglulaus s Tomiugs

» ¥
Sonldaugmdoyaimniu



13

farehead

eyes

ngse

mouth

chin

U7 2.12 M3 HMM

2.5.1.3 M3a¥199% 3 1A (3D Reconstruction)

Wumsadienn 3 57 1nam 2 06

31';"! 2,13 M5N13D Reconstruction

2.6 MITOMITOYNIULAL RS-232

] Ed
1 = @

a [} ) £ ] = o
nsfudidoyavesnenfiuneifugUnsadevrsdunioneuiinne fiuie

ece,
[ 3]
]
=

ﬁ'gnﬁuﬁamﬁﬁ"m'faﬁt’fau‘,mmmmmmzm5%’uda%gasmuﬂqﬂﬁu Tauunngitilswazidun

I

o e
AL

2,6.1 MiiudatoyauuuvuIu (Parallel Communication)
msfudeyauuumuminziiuniuniodidoyansiias 4 wie 8 fin wieawsa

[y | 4 ! a o [y |
fudedeyaldgege 8 wFeslunanfvasu AN Igagalumsiudadoyngefe 1M bps

= g

Usznaudumsivdedoyafish idndouafunanin N ldnsuuazdadoyari 1dn

d ¥-3 ' o i ] 1
A5 Tuszoen1egaga 3 - 9 was uafmeaNu I IILYeImeR I lunsd 0z do sl

'
= |

¥ 1
wnnfiudmaniinvesdeyaiidedon  wenviniidaszdessufimeiilddmiumsniuau
¥ =l

w 3 A a o ¥ 3 o ' ° =
LBENIATIDTBUMSTUTIVOYRDNAIe Feonduiludosldmonnitdy 2 s iuiin

a

4 . 4 ' d &
woidoyaiinzds ddmindmsdomsdoyaluszuzina Avrdoaldszormavosmoning
1

Tohldiinsfunlfosldiege  duiumsfomsdeyauvvoynsudagniiunldlums
foas



14

2.6.2 Mm3fudadoyauuuaynau (Serial Communication)
& 3 ' y ol =l 4 = w

msdemsuuveyasuiuia Ay 2 uy fis msfemseynsuuuudalnsimiag
msffomseynsunuuozdlnsiia msffemsunudslnsims idyyisufimimogiunis
v @ @ 1y a @ da o ' - o &
Sudsdgapudan dedrmsddeyanndlasiafifefusiavesneufinge? Saeudy

& o = 1 = & o o o o

nitsoztl umovesdyenonfin dumeBniduniesumevedoyn faiunisaadesu

=y s dy 9/ d'{ 1 1] 3y q' 9 - o = o
gmwﬂﬂsuﬂmmﬂﬂ%ﬂwiummamaamauﬂquﬂ 3 @ A dggnauim deya

3
=

o Y] rog A Y o w oM o 9 = ﬁ'
HasnINn MITuABYaLUVeYNITuuNtTINa AT aTudedoya IR gegaiiios 2 nSeq

unsudaszes Inaldqeqn 15-30 was Anmudagaga 20 K bps

e

C

C o
O

O

oy

i 204 msdedoyauuunnn guif 2.5 mededoyanuueunsy

2.6.2.1 Sawrznmeamsdemsteyneynsuuuuezdalasiva
4 9 =y Y e 3 = o = J 9} A
fmﬁ'amﬁmayaaqmmmuasmﬂﬂmﬁ"lnmﬁflummmmgmgmmwms WA WINIIDY

3
a ' = o 3 o T = d w [
msfvawugInsda udezldmatmusdyanannfnmsennuiveaiininiuiae

| ] 1w a o o = ar ' o
mada Ay 'Imrm“lﬂwwummwwmmmunw’lumamuasm%yja dufny

A A 1 a a a o 19 V@ & oa
vosiinfiazdelu 1 i TavSenanuialumsdadoyndy Sns1uen (Baud Rate) Faiinviay

WhiindoTind (ops) wu mndnisdedeyadwainida 9600 SnreSind Aaanalugy
s 1 A 1 W - -4
216 sgldmTums fudsdoyautsindianitu 19600 n¥e 104.1 TuTasSurf wazmiy

»
msfudadoyara 8 imezlauviiy § x 104.1 n30832.8 ulasiuri

07 | D6 | D9 ;D4 | D3 | D2 | D1 | DO

1 1 0 0 0 1 1 0

0O D1 D2 D3 D4 DS D6 D7

lloll Il1l! ; lllll Iluu EClull ; lloﬂ l.1ll E !.1"

,IIHGDD b INT

&
I‘

¥

8 x (1/3600} i = 832.8 Windiund

3 2.16 msdadeyauuueynsudaenniuisa 9600 ndoiund



15

4 = [ o 4 a '
puuvesnidemsdoyaeynsuuuesfelnsia  Suiluazdoauitninedudy
: o A & o = &
sﬁﬂfu:"[ﬁmmsmmﬁam'faya"Lﬁau'Ngﬂﬁmmﬂuwumuﬁﬂﬂugﬂ‘n 217 Falsznouday
4 4 ufie

o

a a = -] = LY at [
1. DMSuAY (Start bit) 92iivuia | T willuszAvasinassdudususeduaninyos

annzmedons vaehdluiinisdedowy ya

-y Y

2. {indieya (Data bit) 9259 nTNATH]

o

udiigfganioln LsB nou Tasdayatiesds

= e a d ¥
019NN 5,6, 7 150 8 TnA 1A

! 1 4
3. Imaasaanzeuguienvi Parity biy S | TnTaeinienh lWdothesuiy

1

28
aya mmmuwuﬂuuagnumu’mﬂwwﬁauamﬂu e Tﬂutaanﬂ1'sﬁwanaxﬂuuuu
>

¥
e b

1Faguie wian dandw &1 Amualdiinsdadoyauunm3ag uddoyaiiny 1§y
¥

u u

= S

(=19

o od Yo = qy-:l A VYo . 1 o © = a
THIUR ﬂilﬂﬂﬂ‘?‘l'ﬂ'l‘iﬂmﬂu " menx"lﬂmmumm " Lﬂuﬂuuma mummuanu
d 3/

“ﬂ'N'ﬁ'l‘lql‘iULﬂﬁﬂFI’EN!Jﬂ']‘;‘ﬂS'Il"l]’dE‘JU%']u’JHﬂ.IEJIJﬁT]S‘UHﬂNTmﬂu " T]S’JlfU‘l"lW'l‘jﬂ 1

= g ¥

Unaag drlie "1 Hudnoug LLﬂﬂu'mgawsnmmmﬂﬂm o lsflany enwse

0 [ 1 o i a ya
muuamsfuunzdoyailuuuy NONE TavlidesiimsnsvaeumIaindid

[

¥
4. iingathuniednmya (Stop bin ﬁflumﬁszuﬁwauwmmm'sﬁuqm’fﬁlga Togozsh

=

3 3 o o o & o 1 & 1 = =
Mundoyailaane aofniiu 1" Feondvinamnndmieingla WU Un 15 1w

#3502 On

D7 | D6 |D5 D4 {D3|D2 D1 | DO
11110 |0to0f(1]1]o

anvizvesmedomaiy ~ 1

OatuznD) D1 D2 D3 D4 D5 D6 D7 gead "

§ uon ulu i nln -01 'E nnn g lan uln :' nlu g

119500 Suad

12 1 (1/9600) Yud = 1,250 Bkl

3% 2.17 m3dadoyavuia 8 Tnuuueynsudaun11519600 bps

2.6.2.2 MINBUABHOSNOYATUNINTGIH RS-232
! d <
nangIunsFouAeuaynsy RS-232 hinasigugaamassuiivenuuuin
e ldlumsdsdeyaoynsunazuvuesdlasta 2 fams Tardmualfiissfudoyon

o

» ¥ , &
AR 3 - 15 V A mSuanIn 0" uag (-3) = ¢15) v dmSuassn "1 AU una 14 ezlisedu



16

ussiuildlumemizansn "o uas asdn "1" uanaeeen lnnszuuloSaTnoarg 1u &4
iuﬁ'uusaﬂuagﬂ sv dwanalugUil 2.8 m3aelfaideatigunsalfivamhindey
AVUTIAU AN 0 V - 5 v voaluTnsnouTnsamed 1mﬂus~ﬂummu‘nmm1 (+3V)

n3ofindt (-3v) Immﬂﬂwmmwimnmmmﬁmaﬂﬂma“lm"lamﬁmagﬂmai MAX-232 &4

wannang luiade 2.7

v
F'y
+3V) - (+15V)
I.OCI "0"
0 Pt welufignsons RS-23%
n lll l'l "
(-3¥) - (-15v)
+5V Ill [1] lloll “l“ Hull |
0

- b afiudynnmens TTL

U7 218 szdunsefuvesdynaeynsn Rs-232 Ay TTL luanuzasin "1" 4@y 0"

mﬁmjwumsﬁawimmuaumu RS-232 gnosnuunuiiiellunudiinidouse
%yaﬁﬁaﬂﬂﬁmﬁui:wfinqﬂﬂmfﬂauﬁma{ﬁmq Tngldhmuagiiuuvesgunselifon
ﬂ'a‘ﬁ’mﬂa (Data Terminal Equipment : DTE) ﬁuﬂaynﬂmuma (Data Circuit Terminating : DCE)
Phgunsol DTE sxdpattugunssiifinszinamlud wu Tulnsneuinsaned 1o
“hf[mﬂaummﬂwmmmmmsn”luﬂﬁﬁ%ﬁmmaunuuuaqﬂwlﬂ awuginsel DCE o
Amnbiidhufeadasudeyafidanan prE ity TaumsSudedoynsenegunsdifimes
NI MRS RS-232 foumnsravaagilngel DTE uas DCE othenitafiiy ldiade
newinanives DTE wwiiludg diwneusineodves DCE sxfudade Fenoiaves
nouR oA 1 fuegi Tty pre dunoutnmoive ludvenduuuy peE
WIATIPLNTETOURBUULDYNTY RS-232 95 1MeuTinAD ALY DB Ao DB-9 ff
Tavmouitinmediuy DB-25 vfivelfaudivs o dumuiortunowdiamesiy op. 9
nmqnmmnumﬂarhmmluaﬂmﬂﬂwuumﬂmm"lumnun TaouanegUsuuasdum s

512,19 (M oz (1)

L)



L AL

ﬁi’nuaﬁ ANa TRTS 0NN A TRN TSy t7

(n) AOITINMBTOYNSL 9 41 (DB-9) () AvuIinABT PYNTN 25 ¥7 (DB-25)
P d ¢
Ui 2.19 nouiiawesiuy DB-9 uas DB-25

frmmmﬁmﬂummaummmfmme'mmuuaﬂluﬁﬂw 220 1 gnesuanad
At amsdsdoya °lug1J1q 220 (n) WumsiFousonuy Null Modem nio M3FouseTauns s
Taw iAo W Tud Iﬂuun1sﬂs'mﬂﬂwsmmuﬂwmﬂuzﬂu‘uu daugilit 220 @y dunng

$ouABLUL Null Modem 1uaﬂymzﬂmmuﬁiytg1mmuq 3 1 'Iﬂmﬁwuammwwann

F 4

@ﬂmuwmmmaumm:muqﬂmmﬂuﬂinﬂ fmfunuazidoaidal

TxD TxD
RxD RxD
RTS ::;><::: RTS
CTS CTS
DTR DTR
DSR :::><::: DSR
GND |« » GND

(M) MaFouADUATBINUHONULY Null Modem

TxD TxD
RxD RxD
RTS RTS
CTS CTS
DTR DTR
DSR DSR
GND i« » GND

() M3FENABLUY Null Modem TaldmeFannauiios 3 1dy
JuUn 2.20 ﬂm%'am'ﬂqﬂﬂmfmuuaﬂﬁ'uwa'fmaqﬂ'smmﬂauﬁmaﬂuﬁnymxﬁwq

=5 g 4 o o = J L] de s 3 Qs 1 LY
mumwgﬂxmwmﬂaumﬂmm%:u 2wy uﬂm'ﬂwmﬂmnymzﬂawﬂu AU

Wosd i swesaodyanu fauanans e 2.1

62353

AaUIimaB LY aoulana iy ¥ounamwdnyn AT




18

DB-9 DB-25 RUVGETIRL

l 8 Data Carrier Detect : DCD Input
2 3 Received Data : RxD Input
3 2 Transmitted Data : TxD Output
4 20 Data Terminal Ready : DTR Output
5 7 Signal Ground : GND -

6 6 Data Set Ready : DSR [nput
7 4 Request To Send : RTS Output
8 5 Clear To Send : CTS Input
9 22 Ring Indicator : RI Input

M3149 2.1 ﬂ'l'i5ﬂﬂ1ﬂﬂﬂﬂﬂulﬁﬂlﬂﬂgﬂuﬂ‘illlm‘].li.l'lﬂ'i']j'l'lnl RS-232 111 DB-9 148 DB-25

Data Carrier Detect : DCD %5901959091 Carrier Detect : CD mf‘;nzuaﬂﬁm%ﬁmsﬁa
faygrumongunsaidomsdoyn Wy Tududmiunsidanalng mﬁ’ﬂx"lxi"lﬁ'gﬂﬁam
NN

Receive Data : RD %10 RxD “l%’mﬁa%’uﬁ'mmwmmmsm%’mﬁ\mﬂnﬁmaﬂﬂUﬁﬁ’f@gnﬁfim
WU B33 amestiives

Transmitted Data : TD #38 TxD T%Lﬁﬂ'ﬂ'ﬁa:gmmﬂauﬁ’smaﬂﬂuﬁﬁ’fﬂgaﬁaﬁuagﬂu
ileidmivdsdoymiiudiddoyasenty

Data Terminal Ready : DTR L“T‘Jumﬁtyﬂpmﬁffaaaﬂmrlﬂanﬁmaﬂ'ﬁ'a‘lﬁqﬂﬂmfﬂmuma
fu{hdosmsdndedn Tavwr DTR fsdvadounedun Dy vosgunseitaemannzan
DTR wesginsailmumaeszdouiondefun DSR vosnoufiisns S l¥msdouseiuy
Null Modem Tudnuneildmodyanonios 3 du wdoudouden, DTR 1Az DSR 18347
ﬁumm’fﬁwﬁmmﬂunitﬁmﬂﬁuﬂmﬁ'amiﬁi%’ﬁﬂﬁmnﬁumﬁ%z#’faaﬂ'aﬁum DCD #2Y
Signal Ground : GND ﬂﬂ’JﬁﬂJmﬁa‘mu

Data Set Ready : DSR l#gfius1 DTR Lﬁﬂﬂiﬂﬂ@ﬁﬂﬁ;ﬂ%uﬁaﬁusxw'i1aﬂauﬁama'§ﬁ'u
gUnsalatoma a1 DSR 1{ﬂxnﬂum1ﬁ1w§u§ui’f’eyamnmuuancﬁaqmﬁmmmn DSR
Request To Send : RTS 1%'6111%”udaﬁtyfym%’mva‘lﬁwnqﬂﬂmfﬂmumaﬁ'qi’fayanﬁumﬁa

aoufiunes lnonfisudyanm RTS fAfon oTs ualuns@iniFlumsiFonsouuy Null



19

Modem 3 @10 1zfoudoudoy RTS taz CTS vaiimeudidaody iealnT fuds
mammmu"lﬁmaaﬂnm

Clear To Send : CTS munzﬂaumﬁmmmmnm RTS mmnﬁmtym"l foyaiinr D o
gnefasen muumuwnﬂ‘lfmwamﬂnﬁauaﬂﬂmﬂammwsaumwauama"ln

Ring Indicator : RI lduamanonusduygradonnina iy Inssnr Undlunmsdemsiluee

' g 4 y ' o o {
lignldaw sxdfdediofinisidousn Tududy Tusuns i Imsastaoudygadiminhy

2.6.2.3 y019M (UART)

' a1 , . o4
UART 883119190171 Universal Asynchronous Receiver Transmitter 49% muﬁaqﬂmtﬂ

o Y Ao ¥ = v & o o o o @ g a :
mmnvsudeyauuvozdslasimiues  UART  Sedhuilvdsudmiunisdeans

1)

=i

DUNTUUUADNRUADS

]
=l

nifindnves UART fie imhiudasdeyafieglugluuvanninnoufiumes 1y
oglugtiuveynsmuesalastaudeoenly uag 'm'ﬁumuﬂmﬁmmmaqﬂimmmv
Salanlai foundudndineufiumodiuuyin iy noudashnenfiunes  Hawenon

UART m,ﬁwaya"lﬂmﬂﬂummammuumw@yaauiwﬂauﬁma{mmﬁau 1 Sz uii

L ] = LY J 1 1
lumsfudadoyn (Baud Rate) whwunsdafeyn anufanaaidaiuszuieniscunon
[ = aq’ EY oo 3 ¥
Uoya (WanannwiITa isudeya Tonessu) udy

molu UART sefidruvessesadrevensauuy Tsunsy1d (Programmable Baud

[

>
Rate Generator) Tgmsfimuasdmsidfudygnamnitnves UART Taudmsfidyina
o

»
16 Un amnsadsdoyn Idanuveardwgmdnd (Hair Duplex) uazyagqWang (Full Duplex)

| o ! = ot ' T ¢ o
Trensduwvadgmandidlumsduwuionaiios aumsauuyagmandiiuamse
Funazdsldndouq i

= alf = A Ly ' A
TunTesnewRunofia Uil UART ﬂ"l%’ﬂuﬂuag 2 wei e 8250 Huflu UART

vl ldiuneui UART mamzﬁuﬂtﬂmmﬁﬁmuumﬁwauamlmm

'
= ar

o w 1 o w d 1 e
woaiu ldmsfunaedadoyagniianudeyd s706 AladnAeum us UART wesi
Atonfhudunuvuues UART ﬂ"l*ﬁ“luﬂaummaﬁ lagneuiuneinniuszdoemivayuns

Marun g Unuuues UART welil

¥

Sniwesnilaie 16450 finwmansafudedoyaldfinmmudy 115200 deiud
uamﬁn?‘ﬁﬁma‘fﬁm%‘uﬁ'ﬂ‘ﬁ’auaﬁm%u UART 'uaﬂmmfuﬁmﬁuﬁaumm%ﬂﬁ?‘%mmfuw
FIFO (First In First Out) v 16 ludidh il miﬁmm'mﬁuum,!ummm”lumﬁuﬂwaua
i 256 Alaiinsedunila TavnouRuaes lulegiiuld UART wefiniolwini Wy wos

TL 16C750 musmmamw FIFO v11a 64 lug mem‘lﬁm:ﬁumaﬁu +5V 1Ay +3v 4



20

-~ ) [ ar Vg ar ey o =3 (=) a Al ¥ oo
Imyalszndandaaumunsnsvdadoynlainnuds 1 wnnglivaeduiidielddagm
1IN 16 MHz
oy o g | = . % -1 RN ¥
aunalsiam anudilumsasdoyanuinuiovos UART wedivae A ldldeeld
a ' < o« o ¥ 4 1 =) & = o/ =
MITUAINOYAVDIRNDUTRUADIT Y HDIVINTINDUANDTEI IFAIILDYDIT R IR

1
Tumsnasdayaiod 1.8432 MHz 1911190

d
2.6.2.4 2030z 3 mN 03 U9INBINOYNIH RS-232
AI{ 1= ot :‘A [ T o \ 9 o é =1
w0 InoNA A0S oo l)amnsonewoinoynsy RS-232 qaaald 4 wese Feazil
YR =1 ] o 1 ar ¥ =1
Faidunily COMI COM2 COM3 Lpy COM4 FIWaIAOUNTUUANZAIR1INTTIY UART
) o' - roa o t = w
nolupouiunes lumiaadaiuglniasinivuens@oaiy
o s ¥ e ¢ a w g Y
msiaumeluvemeinoynimlaznounitidmesdsina 8 dn 8 @Rl
] ar =r ] o o a ' -
Jf UART  upaesauedsimmoinielunesaayninainisodiuis ldnnmsimaos
4 o 1 =} = S 1 o
AuUgILaDIRaiaoyYnNIY 190 wosneynTy COMI fuaamsnagh 3F8H A uHtswnsimnos

=)

1 =1 o v A Y o ' o Faq Y as o = o ¥
FITI9 ilﬁﬂju@ﬂu‘ﬂuflTl'U'JﬂL‘il"lllrlJﬂ‘Uﬂ’] 3F8H T@Uﬁﬂﬁmﬂ'ﬁﬂﬁl‘ﬁﬂ1uﬂuwaﬁﬂai§ﬂ3MM@QH

=]

¢ o 1 Ay o rd
EADTATNIL 00H : 53eanitiivos

Pl

A C o w D3 Ao w . a 0 e aa e o
HhSimmasdmiwmnudoyaiiiudwinazdwonlyd  Tasmsdenanusimmasiinn

A o

kY = Y | 3 o EIEEY A e o o
Wwomnudayandoimsszatean hlizdeafmualdiin - DLAB  TuSSawestmuagiuuu
¥ = <4 2 =1 o dw I~ * [
Hoya (03H) szdvafimoiusTu 0 Famsdoudeyanidfeawsail dunisdedayalUiss?
@y 9 1 5w o g A o oy Y
amos datoyauazdoyasyatoon hluuveynsu  dmsumsiudoya  loSudeyadin
=t 3 o 3 3 [ o saay ¢ 3/ [ ~ 1 e
SevdoouazmloaTusuiuudy foyaszgndundSimaesiiudoya uiewnlinisewiva

o v o n’r_1jJ = o ) ¥ o Y w9 [} L
wosasnll Fimaoilazgninfeiuazwisunioud mivnsivdoyaluluaaely

jat

o <o ' e o 3 ) o dor o
EADIFA WV WY 01 H ;. IR DI WBIUANITOUINDITNHA

o aa o o o - = de o A o 2 o
LU'HS‘?JETL‘FI@SETTH'i‘lJfﬂSLGHL’EJLUﬁﬂ’IﬁﬂumEJE‘S'W@‘I malﬂumsmwu@iﬁ UART #1919

EY H
ot

o o o a 0’-3 o o 1 = oAt o &
TWTHDHNDITHAVLIN Wen%umsmwﬂmmazuwmmﬁﬂﬁm'ﬂiu A

= = = I =Y =Y = =
1N 7 1N 6 10 5 im4 | Una % 2 ~ SILI N 0

0 0 0 0 SINP ERBK \ TBE RxD

a o R 5 _ ey v o = - du o
191N 2.2 WQﬂ"]ﬂlﬂ?Tl‘ﬂﬂ‘ﬂl’luuﬂag'U'ﬂ‘Uﬂ\‘]'ii]fﬂﬂ@'ﬂ@u!ﬂl.'“ﬁﬂ'ﬁ?JULT]@TﬁWﬂ



1IN 4 -1 7

SINP

ERBK

IBE

RxD

= o : o oo Qs
?nmﬂasmmuq 02H . 'S'Umﬂﬂ‘;u’ﬂﬂﬂTH&JQLLﬂ&ﬁﬂ'IHﬂ']SﬂJBNL‘YIE]{SW

Tugnldaw

21

a = a fo o 4 - o = =
L'E]‘LILBL‘Uﬁﬂﬁ’E]'leﬂﬁ‘j‘ﬂﬂl'LlB\W’lﬂlﬂﬂﬂ’lilﬂﬁﬂuuﬂﬁﬁﬁﬂ']'IJA‘S'VHJ'I’EJHWVI (CTS,

DSR, DCD, RI) law “1” foduioiflamssumading uay <o

o

= o w
DUINDIINR

ol = = o o
DUIBIUANTOUINDTIHG

2o -] = = o
lowofiu, wandeyanSowsndoyn Tay o1 Avduedansdumes

- =] = = L4
LAZ “0” ADAMBILANITDUIN DT THA

mummamsaumasswa mauﬂwlmmﬂ
iiansdume i ing unz “o» fodmaidiansSumes WA

o S - o o A =t o @
PURILAMIDUNDI SHALLBID NI Vames Urile$14 3y

& $

Sudadoyaig

3 =

Aodeaians

' -~ = J de
Lﬁmfn1ﬂmﬂﬂ31uﬂﬂwmmuﬁaummqmnmm,

¢
Ll

Tay “1” An 1Buie

YoyaiSeudon  Taw

A o o o do o =] o = L 4
“1” ALRUBIUANIOUIND S SHA HUng “o ROAMIDIUANITOUINDI SN

1N 7

9 5

N 3

in 2

1M 1

11 0

0

0 0

0

ID1

IDO

PND

A a’n‘a o J = ey o
f1319N 2.3 Wanmumﬁmam“luuﬂﬂwmmsammasuﬁﬂﬂﬂuﬂuaz

in3-1n7

DO, ID1

TignTdam

' o 4 a s o o
’lﬂl’f'ﬂusmnutﬁmﬁ'qmmqmsmﬂaummsww

“00” INABUIN BT SHW mmmﬂmanauumJawawmuwﬂ

“O1” INADUINBS SH

5‘10”

- ) & aw
Gonioundl daldy

o

o

NABUIMDS ST

=

o

mIF

N mmmﬂsnmﬂaﬁumﬂas

3

i'rwa:umw ¥ 93417

LY o

) Huw

ar

Y]

o 4 Ls
ADIUMTUOUNDT TS

[ 3 YY)
Weylududy 4

dfuiiududy 3

mmmmauagnmuaﬂmﬁmmmumﬂa'f hniudoya

Jususy 2

or = ! = é =
“117 mﬂaumE){mﬁuﬁmmnmmwﬂwmﬂhmsmumﬂ%gnﬁ?mnﬂmsm‘sﬂ TR

Hud IR

PND

B-

e

a & ]
FHAIUASIAD

o

g

astlugagatiudud 1

. a a LN 4 - = do o
HuansrnmuzvosmafasumeTiud Tay «1» Aoduadanssume s

= =, = ar o«
HaL =0 AoAmoilan 1B unNe s SHe

»

T Tavermursont 18890

- 9/ as = oo n‘nf 1Y ~ s od e = W o=
maummﬂmmfmmﬂumaﬁwmu ﬂzﬂﬂx‘mﬂ'l‘imﬁﬂiﬂ'lﬂﬂuﬂ'i]%ﬂlﬁlﬂﬂﬂ

= o
190UIND3I



22

oo L o 4 a = 1 ! =4
* fufnBumns na uﬁﬂqmnmsLﬂauuuﬂawmmauwﬂ vzdes NI imnesuans

o = ¢ o i - IR - cou #
fTﬂ‘lth‘UﬂQIlllﬂiJ Gﬂmﬂ'ﬂiﬂﬂm‘uﬂ 06H) INDLARUSAINITEULNDTTHA

3 oa o o o o A'a =P o o L] [l B = 1 v o
* DUNABUINDITHN L'LI‘EN‘D']ﬂﬁﬂﬂlﬂﬂiﬂﬂlﬂﬂﬁﬁﬂﬂﬂuE'ITI\‘J ﬂzﬂmwuwagﬂﬂmsnmmm

C7}
a

ar LI o o o v - t " ad L3 = & s

‘]JV]L“.’\'E]ﬁﬁ'd‘UﬂlI“ﬁ (?ﬂﬂmmmuwm 00H) 109 1A IAAD SUAAIADTULDUINDTTHA
¥ e A LN 4 - Y o e ¢ o fa  w ¥ o 3/ Y

O QUNADUINDITHN L‘LJBQi]']ﬂ"lJ‘al‘J‘ﬁQﬂtﬂ‘]Jﬁdnluiﬁ]ﬁlﬂﬂiﬂﬂl?‘lﬂiﬁ?‘ﬂ'JT‘U‘llE]ﬂ%IﬁLﬁU"UﬁﬂfJHﬁ'J

3 a daa o as o* t T o o o
wAUNAEsMDWMeS IHd laemisemdayannismaoiivives

¥ oas oo 4

i o - ' & o
* Duindu meadfwi asnnanuianmalunisteneateyaniafanisusnizdounins

1= w ' ' o a 1
Mdumeiinalasmssudniniimansuansaamzmsfunardadoyauuveynsu

S ) 1 vt oo 3/
JIAADIAN UL 03H ¢ 5ﬂﬁiﬂﬂiﬂ1ﬁuﬂ§ﬂllﬂﬂlﬂﬂfﬂyﬁ

1Un 7 10 6 in 5 1n 4 11 3 U1 2 n 1 1M 0

DLAB BRK PAR2 PAR1 PARO STOP DABI1 DABO

P ¢ 0 ' - L] o o
MI1N 2.4 Mangumshouluidasinvessiamessmuagiuuvesdoya

DLAB T3 Tunsfmuaniinmsiinuvesisamesivines (0omH)
=] 3 [l '
“I"iflumsidg Tnuanismisauease
07 Humsidhds immesinives FHamosauvua 00H) taz33mnes
o w o Y Y Qs I g ]
dmiuduedianisdumesing Giamosdumis 018)
1 & of) ar o« Ay = o a
iatin DLAB iilu “1” Siemefivies (00 uasiimmesiduaanissumaSwe
01H) e l¥dmiuInandinsmsanuddmiudmuasensalasisames 00H 1Bus
w e | o o v o o ' -t o
M1 A1 fuSimmes olH THAumdms ludga mamsaueasamusadouiiu

aums 1491 ueaism = 115200 / mdama 16 In Tasfuay 115200 fo Awavewmianealy

Y =

4 . ) = y = = a
2193 UART Hmimsmsmanuonieluniownsufiuneinldnsaneannud 1.8432 MHz
2w 16 MW IdR 1D 115200 Hz wozdams 16 n Ao TeyaluiSames oon + (256
Joyaluiiawos o1H) cuwdhdesmssoaagegai 9600 inaeTifl sidamsidoeld
U é U y ] A l
dosdiantly 12 Ferhilozdoagninanasluiiaaes ooH wnz Tnand 0 as T ames 011
BRK Tdnuguasngacioneadeya Tau 1" awsonganiowsnld uay <o 1
] & ¥
Imsvgansoluinla
A -4 Qﬂw
PARO- PAR2 1diflefmuawia

000" hildw3a



STOP

DABI,

»

“001” AMuAWITAR
¥
011" MuANITag
o
“101” ¥15N (Mark)

“111” %89714 (Space)

o a an ¥ -3 3 =] oo
ATHUAT I IUTNT N IﬂU “1” Mﬂﬂﬂﬂﬂw 2 Un itag “0” uun

L a

DaBo 1 wdulumstmuainnuinvodeyaiidesnisdronen

3 voa =

“00” TN NYoUANIAY 5 1)

Y

@ =

“01" MMUIULINIDNAMIAY 6 1

]

=

3
4
“10” S uindoyawiiy 7 On
¥
q

“11” Smindeyaifiu 8 dn

a o o * e o o
TUMADIA WML 04H ; TvmaeinIugu luay

23

=3

N1 un

n 7 in 6 N 5 v 4 im3 in 2 in1 10
0 0 0 LOOP | OUT2 | OUTI RTS DTR
A:i o o o 1 = ool o a
MmN 2.5 AandumsihanuludasinvesiimnofatuguTudy
ins-in7  Tugnldam
LOOP “I” Buedianisaesndu uag “0” Ameiia

o =Y a4 =
OUTL, 0UT2 1" wwebanms 1gaunielu uaz o fawidia

RTS
DTR

Sameidumy 0sH : Smanduansenugnsfinaedsdoyaoynsuyes UART

Marwgunisinuesn RsTas “1* Sueiiauag «o0” dmorda

M¥nrugunrsieueesst DTR Taw “1* @uoidauas “o- fmeda

o

] a o I'd & @
Tdnuswiusimeesuans InuanazanuzvoinssumeSng

4 = = [V 4
02H) (HBLAIT UMAYDINSIRAMIBUIMDS S

) L) 1
TITEDINWH U

1n 7

19 6

ins

1in 4

1n 3

i1 2

I 1

0

TXE

TBE

BREK

FRME

PARE

OVFE

RxD

1] ‘
A19197 2.6 Wqﬁnﬁ’umﬁ'ﬁwm1uumf\:wmmmmm{ﬁumm 05H



24

TXE (Transmitter Empty) “1” ?’%‘ﬁma{ﬁmﬁ"nﬁ'aﬂﬂua’ha

0" Sensiifoyn 1 luditueghiTimnaidmivdedoya

TBE (Transmitter Buffer Empty} “1” imnoiiinasdmiudedoyaig

“0” fanalidoyn 1 WuafiueglhuiTimnef o dmivdedeya
BREK (Break) “I" UART A599WLAISIUSN

g Tufinsiwsn
FRME (Frame Error) 1" UART as7nuamianatadnunsudoya

“0" liwuanuianaadninsudeoya
PARE (Parity Error)  “1” UART AS9WURNAANIANISWITE

“0" luwuamufiawaanianiza
OVRE (Overrun Error) 1" UART A59WUANNRANA1AULL 101095 $3

“0" uwuanuAewaauuy oo $u
RxD (Reccived Data Ready) 1" imisfudeyarthmuiu 13 luiives

<o~ Tulidoya

e . o v aAry o o
ﬁlmﬂﬂ'gﬂ'ﬂmui 06H : '5*nﬁmmxmmﬁmuzmaﬂumn

4 L -3 é U o
ldifoumaamo iz oy adunavemeinoynsy Rs-232 $918uf Faa m DCD.

Y
¥

DSR, CTS uag RI dmivmasenae [Famnvuoundseaed Ss1vazBoasst

in7 | fne | fins | dna | @3 | im2 | i ﬁnﬂ

DCD RI DSR CTS DDCD DRI DDSR DCTS

:; o’nla o 1 = ey o o
114N 2.7 ﬁQﬂTUﬂ1§"l’l’]ﬂ"luslullﬂﬁﬁﬂ“l’]ﬁ]ﬂfﬁﬂﬁ&ﬂﬁ]ﬂlﬁﬂ\ﬁﬂ'ﬂ‘luzﬂllﬂﬁ'hllﬂll

DCD (Data Carrier Detect) THuamsaninzyaw DCD
RI (Ringing Indicator) THansan1nzansy R

DSR (Data Set Ready) I4ansern19z 49911 DSR
CTS Delta Clear To Send) uaasern1izvean CTS

. ¥y 9 A aa J -,
DDCD (Delta Data Carrier Detect) Jidenisialasuntasitfiaduaesiin Dep
r 1 » *
“1” 1799310 DCD iRansilanunlaafioousuniss usnssfiuds
124 d‘ A'l - [} 1 1 ns: :1 9}
o7 lifinsulavunlaufiafeusunissuandafinga

P - oo J =
DRI (Delta Ring Indicator) Taudemsudfoundasiifiafuunsiin rI



25

¥

“1” LAANDN RI Lﬁﬂmim%‘;uuuﬂamﬁmﬁuuﬁutmiimfhﬂf’qﬁuﬁ"a
“0» Winsnldowaadedougunssiudniaing

DDSR (Delta Data Set Ready) H'u.%msLsﬂé‘uuuﬂmﬁtﬁﬂﬁuumﬁw DSR
“1" @9 NN DSR Lﬁﬂnmﬂ%‘uuuﬂmtﬁmﬁuuﬁumﬁémfhﬂ%ﬁttﬁ'ﬂ
“0~ lifinsiAvnuausiomonsunss e S

DCTS (Delta Clear To Send) ‘l*ﬁ’m’fqmmﬂ%‘uuuﬂaqﬁxﬁﬂﬁuwaﬁw CTS
“1" uam91n CTS sﬁﬂnmﬂ%‘uuuﬂnmﬁmﬁuuﬁ'un15iimmﬂ'faﬁuﬁa

] ] ¥ ]
0 ldfimsuaenstanfiodousunisemndafiuda

Hawoidwns 070 : Faweddmiuindoyatinsn

a i ] ] o t -t pr-r-}
Amhfitunuaeanud RAM wwia 1 lue mﬁmmmmuu%mmwmasu"lu

dinalag Aon13¥1199U4 UART

2.6.2.5 dnvardyauEuyaunzIoynuBIneIn RS-232

ol

dygrauedinaildniugy (RTS uaz DTR) ATy IULANIND U BUYA (CTS,

DSR g DCD) wvanesnoynsy RS-232 agnndvaniuznoiugy UART audye

- 4 ar

‘Ilflgﬁ‘ﬂQﬂ"lﬂﬁduﬂu'i‘ljﬂwg]ﬂﬂﬁﬂﬁﬂ"m“‘ UART 9% ﬂﬁxﬂ‘lj’ﬁmiy']mlﬂ'mﬁﬂﬂﬂﬂﬂWLﬁMLL‘U‘U

£ g )

TTL L‘V]'l“l—J'LI muumaﬁagmmmﬁm%mmn UART ‘ﬂ\‘lﬂﬂﬂﬂ%ﬂ]"l?f".lﬂ%‘i‘“‘lj lWﬂﬂiUﬁtﬂU

o oA

wsadu I Idsedudygnoniiu ldawmesgm Rs-232 deudseenlvinaouiuned gy

€

A 1 -] ¥ - o w dy‘ ) a A a a
madouaulaemenszaesliisfuludnvasigudortu  Weld18ssfudygassdu

] W 1 o o wnl: o o o 1 & n’: a
wEInyY LlGI'N‘ﬂ‘i‘U‘UVﬂ‘BYNﬂ']UiHﬂﬂlIWJhﬂﬂiilﬁzﬂﬂﬂimﬂﬂl‘]i'ﬂllﬂﬁ'lﬂ‘ﬂ'liuLIﬂ%gﬂﬂ'ﬂll’dmuz

2.6.2.6 UPALATEUDAN B‘;ﬂﬂ‘l-éﬂ‘i‘u

ke

Qs

meﬂmﬁugmmmwafﬁmqﬂmﬁ 4 AunUaAl
COM! : 3F8H
COM2 : 2F8H
COM3 : 3E8H
COM4 : 3E8H

A A Y A & 3 o o o o "
LlIE]L'iﬂJ!.‘IJﬂLﬂﬁ'ENL'WE]GL‘TN’I‘I.JF]?JJJW'JLWB'E vl‘lJf’JBﬁﬂ'lUcLHﬂmJW'JWIE]'iﬂz‘ﬂ'lﬂ'liﬂi‘l‘ﬂ'ﬂ'ﬁl‘lj
w
LIAATAUDINDIABYNIUNIMLA f1lueeans sonuusnnsaveanesaeynsy luserezii

woawnsaiinsiowy Tdu B unieausivune 2 Jud laedswazisoasst



26
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1. aalsungu Microsoft Visual C1+ 6.0

2. 241U 50n54 Microsoft DirectX 9.0 SDK (Summer 2004) Iﬂﬂﬁ‘ﬁfuﬂﬂuﬁﬁ‘f‘:
2.1 ﬂ‘!’lﬁiﬁﬁﬂtlﬁﬁ] 10 www.msdn.nicrosoft.com/directx/
2.2 1onaanounuding1
Together with samples
Nate 11514 OpenCV Beta 5 92489%11019 build library 2 §72 9 strmbased.lib tias
strmbas.lib 1918 library 2 St i library 494 DirectXSDK ﬁq&umﬁﬁmﬁwmsaﬂﬁv\i

DirectXSDK #nuda 2 #lanatitnady

3. 23113UNSY Microsoft Visual C++NET 2003
Note Tuns a4 DirectXSDK nos¥ufieinsa build library 2 §a8ang 1718 Tegld

Microsoft Visual C++ 6.0 Alu$uiudpeas Microsft Visual NET 2003 5

4. 1A 19083 11)3UnTU Microsoft DircetX 9.0 SDK (Summer 2004) (3ou300ud 1810
Junevdadl
4.1 Tunsd@iile Microsoft Visual C++ NET 2003 11Tl file 10
<DirectXSDK>\samples\C~+\DirectShow\BascClasses\baseclasses.sin H3
aluﬂ‘iﬁ’ﬁlcl‘ff‘ Microsoft Visual C++ 6.0 19dla file ﬁ‘d]ﬁ]

<DirectXSDK>\samples\C—+\Direct Show\BaseClassestbaseclasses.dsw

4.2 119 Build -> Batch Build -> 1fion Debug 1ag Release Configurations -> Build
4.3 Copy strmbased.lib 910
<DircctXSDK>\samp]cs\CI—f‘r\DircctShow\BascClasscs\baseciasscs\debug oy

strmbas.lib 9710
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<DirectXSDK>\samplesiC++\DirectShow\BaseClasscs\baseclassesirelease 11 139

<Direct XS DK >\ih
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4.4 179 file

<DircctXSDK>\samplesiC++\DircctShow\BaseClasses\baseclasses, {sln/dsw}

4.5 ul‘ﬂﬁ Tools -> Options -> Dircctories -> Include files LL&%’JLﬁﬂJ

<DircctXSDKlInstallFolder>\include tiai

<DirectXSDKInstallFolder>\samplesi\C ++\DirectShow\BaseClasses 141 11

4.6 ulllﬁ Tools -> Options ->Directories -> Library files LLﬁJ’JLﬁlJ
<DirectXSDKInstallFolder>ilib 1411l

Now Mo 4.5 uaz 4.6 1o fite fisuiud 1) Bunga

5. 911J51A30 OpenCV Beta 5 #1a121 Tnaa 1690 www,sourceforae.net 91LURBRINS
v v

5.1 Lﬁ'?J c:\opencvibin Tu System Path céﬁwu Windows2000/XP ¢1115 ﬂﬁﬂﬁﬁﬁﬁy
MyComputer - > [click U] - > Properties -> Advanced -> Environment Variables.

5.2 19 Microsoft Visual C++ 6.0 1A file “?8 <opency>\_make\opency.dsw Lﬁ’t’)‘lﬁmﬁ

build .
A TUsunsundnune OpenCv

5.3 ul‘ﬂﬁ Menu Build - Batch Build -> 1900 W1z Debug N1 Release Configurations
i > Build Tuduaeniioawnth 2 ads fazniaileaninTalsunsa bateh
build Av1Ranuals 1

5.4 107 file ﬁilﬁﬂﬁjﬂ file ‘?;E] <opencv>\_make\opency_directshow.dsw

5.5 1ﬂﬁ menu Build -> Batch Build -> 188f My Debug tinz Release Configurations

WM -> Build
» 1 ¥

[ ~ ' 9 ] 3 Ci dy 1
Note nAfafifinisaslalsunsy OpenCV Tmiazdashiatudiunoud s 5luvavue

- Kl
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m3suldsunsunldlavssve daiugs
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anasaiiEu Tsdalmif 19 aus Suod Tome? 2w ABINIMIALNT (Path) uagd
i armdunouso i
11_]1/1 Menu Project -> Settings -> Setting For (Hmmwm) -> All Configurations -> 10 I%ﬂ
project ->  C/C++ (mnmw 11) -> Category -> Preprocessor -> Additional include directories:
Tt -J.feviinelude,. /. /otherlibs/highgui,. /.. /evaux/include,. /. /excorefinelude (Lund

-
IO )

ﬁmr-u;Fu ﬂtwiw-h:ru T Geeerd ‘ Dstup  CTee | Lk | Asvane m:

= Conpr ST - e
Cvast oL e
- Piapatgecaorn delriiona .
{WINT?_CONSOLE _Hbrs ™~
Undolined ayesbmis: 17 Undahoe o symbeh
mﬂlmandwb dm:

{7 devirciade, 2 dal whs, /e

17 lgnote ttadid mchade paihs

Connn (ptvng

Jmmm.rm 2 e nchade” W
£ Jothanlla g™ A L icvausiciuds’ A
| 1 feoenchds” D WANT® 0 CONSELE o,

. e

] ¥
31.!‘?! .1 MR lud e All Configurations Preprocessor

2. 1 Menu Project -> Settings -> Setting For (Hﬁ“ﬂlwcﬁw} -> All Configurations -> Honfidn
project -> Link (ﬂ‘LTWiNﬂJ’N)—:‘ Category -> Input -> Additional library path:cl’c’f'

. Mib /. fotherlibs/_graphics/lib (LUNFE BDIT19)

ovivgs Fo [iTEtgamoni "I | enens | Db | OTu Lev | Rerarc -:
= oy MMM e |

h | ObeectMoray poded.
Tl T2 (e 32 Wb g W weapock i conig 7

Jarore iblanes: - Ig e 31 datp e dine
Foice sprbol iefsipme:

Agideanal thairy pat
f?ﬁb?vmm;mﬁ;li'
Cmﬂmﬁum

keme\}? [ Inu32 Im ;.i'_;; Wb Wmdlb e
Fey 2 W thek 7 o ok22? o
ETEES m-lhndx:i?ﬂandx:tnrihf,.*&p .

31]?1 4.2 MIFIM iudurad All Configurations Input
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3. M# Menu Project -> Settings -> Setting For {_‘}*T‘LTW'N*%U) -> Win32 Debug -> foniido
project -> Link (ﬂﬁ’whwm) -> Category -> Guneral -> Object/library modules: 1W3

cvd . hib highguid.lib ¢vauxd.lib excored.lib (utmé’hu ﬁfﬂﬁ’jw)

g Fo (Wnitbetug Geetal | Dobug | Do Lew ‘ Sesewa (7]
B Conone MM - e
Do g8 cva k
it n Ubpect Aty prockdes
ol G0 W g e W cosonsd s ki3 i i 3
| moré Frranms Igrcve al defaul sbyanes

Fotite 4yonbal redeenegs:

Agdfional by path.
f”ﬁ?ﬁu&ﬁﬁi{}‘_};;}ium

] L
31N 0.3 maaamluaurns Debug nput

4.1 Menu Praject -> Settings -> Sciting For (‘}’T‘LT"Iﬂ'"N“j’hEJ) -> Win32 Release -> lnoniio
project -> Link (@) -> Category -> CGeneral -> Object/library modules: JH

cv.lib highguilib cvaux. lib excore.lib (Lundy H99719)

Praject Scthings

b hadw i v H: Cueta it b el 32 e 32, W
Fgrean B 77 Igrone sl defaud datas

Preta :ymmlw)umres

ay dlx:hdltwy (%10
2T G _gaherdt

b Highgas Cvane b crcois W kome 2
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e |

i ¥
3Uh 0.4 m3fam1 luFume Release Input

3, Click “OK"

1 ' o P24 o ~
6. fomdaaiim iy ldsaasluauveusi ne

6.1 Menu - > Project - > Insert Project Into Workspace

6.2 FonId fail c\opencvicvisrelev.dsp

c\opencvicvaux\srcicvaux.dsp
c:\opencviotherlibs\highguithighgui.dsp
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7. 1% Menu - > Project -> Dependencics
d1M5Y "cvaux" DN "ev",
§11 91 "highgui" 1A0A "ev",

r v W
TMTUTD project MTAATDR "ev”, "cvaux”, "highgui”

Praject Dependencies -

Project Dependencics, |

Select progect lo modily. Seiect prowed o modiy:

iighags - -t

. A s
| Cancel |

i Concel i
- Dependert on the folamng projects} : : Dapendant on the fokwing project|s) s

heghgu 2 leveRal

Project Dependencies

i
¥
|
‘

gﬂﬁ 4.5 MIaInT luduveg Project Dependencics

I E 9
8, Na “OK” WQQ@')W%UﬂWﬁEWﬂﬂWWWQ”‘]LLﬂQ

] , d o . . ¥ .
9. pou UM Build TJ5@au00131 1A Menu - > Build - > Batch Build U&7 (o0 build 1911z
Debug Uaz Release Configurations M3 91098

! 1 . ' o ¥ o ]
10. 10 lsimy ervor 1M build wwen1wi1 Tlsunsu IdhnsadeTisdavouswda dow
Y e 4 A -, & v 1 v 3 o
AEININTIexecute AIFSWUI IHONA exccute U window ‘U‘ullﬂﬂclﬂ"ﬁﬂulﬂﬂﬂﬁ’lﬂ@m‘iﬂ'lmi

o - P d ¥
exceute A34H #1111 Browse - > ud2 TfudfluTus8nvewust - > uflu Debug - » 1500 execute
§ ar =] 4 - q’: =1 = [ =t ' u’:

TWddusooadulisdn Feiaduiufeiogdios IWddvuviniy

1 Fd W

= u = LU | o o 9 o t Y
1L DA excente 1A a3THTIAIR N TEWS LALLM 1Y Wanueanun Tdsunsy 14
o = (7 9 i - =1 [ [] o 9t A 9 o
YNNI exeeute TBUTOEIED UAMS run 1lsAAve0I 18 IdmuITaritlE slioanimsideeri
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w of A . e w 5 :I.
12. AA0DA (copy) %o haarcascade frentalface altxml NHURANHME <~@) 1INy

OpenCV/apps/Haartraining T AR i execute file VD43

= 4 ~ . A . a diy 3/ = ¢ A s Jvl
13. ABNYITN execute file - > Edit Ju Notepad Y138 Editor alanld - > Wuw Fo project LiA7)
1 Y d =
AR --cascade="haarcascade_[rontalfoce_alt.xml" |1 1N project 49 facedetect fl Twuw

b

A4t facedetect --cascade="haarcascade_frontalface alt.xml"

o ; 1 =1 ar
14. save as 1H0Eo project.emd 144 facedetect.cmd 1011311 ullu@o i execute file WHIUI

a o v = = o
TANHITHU icon 3zsTIugUiRes

a ¥ , ¥ o r Y i WA 9 [ . A
15.JunsFun ¥ project 1zdoeiin1sdendotuas port serial WE0U¥e0 189 double click 7

L A
.cmd icon {icon EﬂLﬁUS) Aafa 1 ude 14
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Tdsupsuawmsumsavluninn

fifndet EiC
#inchide "cv.h"
#include "highgui.h”
dinclude <stdio >
finclude <stdlib.h>
finclude <string.h>
#include <assert.h>
#include <math.h>
#include <float.h>
#include <limits.h>
Finclude <time.h>
#include <¢type.h>
#include <windows.h>
sendif

#ifdef EiC

#derine WIN32

Hendif

static CvMemStorage* storage = 0:
static CvHaarClassifierCascade* cascade = 0

void detect_and_draw( Ipllmage* image );

const char* cascade_name = "haarcascade frontalface alt.xml”;

fidefine BUFSIZE 1200
char *pcCommPort = "COM2";
unsigned char buffer[100];

DWORD inbutter=100;
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DWORD outhutter=100;
DWORD dwBytesRead, dwBytesWritten, dwBufSize=BUFSIZE:
HANDLE hCom;

BOOL fSuceess;

int conf_portivoid)

{

DCRB deb;

hCom = CreateFile{ pcCommPort,

GENERIC _READ | GENERIC WRITE,

0,7 must be opened with exclusive-uocess

NULL. # no seeurity atteibutes
OPEN_EXISTING, # must use OPEN EXISTING
FILE_ATTRIBUTE_NORMAL, # normal file
NULL # hTemplate must be NULL for comm devices
I

if (hCom == INVALID HANDLE VALUE)

I
8

/i Handle the error,
printf ("CreateFile failed with error %d.\n", GetLastError());

return (1);

}

# Bulld on the current contiguration. and skip setting the size

ol the input and output buffers with SetupComun,

fSuccess = GetCommState(hCom, &deb);

if ('Success)

)
L

A Handle 1he error.
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prntf {"GetCommState tailed with error %dAn", GetLastError());
return (2);

f

SEHEn DOB: 57,600 bps, 8 data bits, no parity, and 1 stop bit.

deb.BaudRate = CBR_9600; ¢/ sct the baud rate
deb.ByteSize = 8, 4 data size, xmil, and rev
deb.Parity = NOPARITY; # no parity bit

deb.StopBits = ONESTOPBIT; /7 onc stop bit

fSuccess = SetCommState(hCom, &dcb);

if ({fSuccess)

{

< Handle the error,

printf ("SetCommState tailed with error %d.\n", GetLastError());
return {3);

;

printf ("Serial port %s successfully reconfigured.\n", peCommPort);
return{0);

|

int main{ int arge, char** argy )
i
CvCapture* caplure = 0;
Ipllmage *frame, *frame_copy = 0;
int optlen = strlen("--cascade=");
consl char® input_name;
intk;
k=conf port(};
fSuccess=SetupComm(hCom, inbuffer,outbuffer);

il arge > 1 && strnemp( argv[1], "--cascade=", optlen ) == 0)
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cascade name = argv]l] + opiten;

ipul_name = arge > 2 ¥ argv{2] 1 0;

3

fprintf( stderr,
“Usage: facedetect --cascade=\"<cascade path:\" [filename|camera index]\n" ):
return -1
Hinput name = arge > LY avavi ] 05
'
cascade = (CvHaarClassifierCascade* evLoad( cascade name, 0,0, 0);
ifl lcascade )
{
fprintf{ stderr, "ERROR: Could not load classifier cascadein” bR
return -1;
i
storage = cvCreateMemStorage(0);
if{ tinput_name || (isdigit(input_name[0]) && input_name[1] =="0") )
capture = cvCaptureFromCAM( linput_name ? 0 : input_name[0] - '0' );
cvNamedWindow( "FTS", 1 );
ifl capture )
{
tor(:;)
i
if{ tevGrabFrame( capture ))
break;
[rame = cvRetrieveFrame( capture );
il Hrame )
break;
ifl 'frame_copy )

frame_copy = cvCreateImage( cvSize(frame->width, frame->height),



IPL_DEPTH_8U, frame->nChannels );
if{ frame->ongin == [PL._ORIGIN TL )
cvCopy( frame, frame_copy, 0 ):
else
cvllip( frame, frame copy, 0 );
detect_and_draw( frame_copy );
HlevWaitKey{ 10 y>=10)
break:
i
cvReleaselmage{ &frame copy );

cvReleaseCapture( &capture );

clse

const char* filename = input_name ? input_name : (char*)"lena.jpg";
[pHmage* image = cvlioadlimage( filename, 1 );
1 tmage )
4
detect_and draw( image );
cvWaitKey(0);

cvReleaselmage( &image );

[

else

Fassume itis a text file conlaining the

list ol the image filenumes to be processed - one per line */
FILE* t = fopen( filename, "rt" );
if{ )

1
1

char bufl10004-1];
while( fgets( buf, 1000, £))
i
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int len = {(int)strlen(buf);

while( fen > 0 && isspace(bufflen-1]))
len--;

buflen] = "W

image = cvLoadlmage( buf, 1 );

if{ image )

{
detect_and_draw( image );
evWaitKey(0):
cvReleaselmage( &image J;

i

felose(f);

-

——

cvDestrovWindow("FTS"™);

return Q;

void detect_and draw( Ipllmage* img )
{
int scale = 1;
Ipllmage* temp = cvCreatelmage( cvSize(img->width/scale.img->height/scale), 8, 3 );
CvPount ptl, pt2, pt, cen;
int i, subx, suby, xout, yout, zout ,z1 ,z2;
char out[4];
cvClearMemStorage( storage );
1{ cascade )
{
CvSeq* faces = cvHaarDetectObjects( img, cascade, storage,

1.1,2, CV_HAAR_DO_CANNY PRUNING,
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cvSize(40, 40) );

for( i = 0: 1< (faces ? faces->total : 0); i++ )

CvRect* r = (CvRect*JevGetSeqElem( faces, i );

ptl.x = r->x*scale;

pt2.x = (r->x4r->width)*scale;

pti.y = r->y*scalc;

pt2.y = {r->y+r->height)*scale;

if (xout==0)

i
1

it (yout==0)

pt.x=(ptl.x+pt2.x)/2;
pt.y=(ptl.y+pt2.y)/2;
cen.x=180;
cen.y=140;
subx = cen.x-pt.x;
suby = cen.y-pt.y;
if (subx>40) xout=1;
if (subx<-40} xout=2;
if (subx>-40 && subx<40)} xout=0;
if (suby=>40) yout=1;
if (suby<-40) yout=2;
if (suby>-40 && suby<40) yout=0;
zl=ptl.x-pt2.x;
if (z1<0)
zi=-z1;
il (z1<90) zout=1;
i {z1>110) zout=2:
(2190 && z1<110) zout=0;

printf{("zout = %d", zout);

A b= forward, Brhackward, Us-up D=down L 1e LR

~right
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it {zout==0) {out{0]="a;0ut[ 1]1="0%0ut[2}='1;0ut{ 3}="b" }: /o moving
it (zout==1) {outf0]="a"0ut[1 [='0%0ut[2]="2"0ut[3]="b";}: )0
it (zout==2} {out[0]="a;out[ 1]1='0";out[2]='3";0u1[3]='b":}; ~R

1
y

il {yout==1)

if (zout==0) {out[O]='a‘;0ut[1]:'O';out[2]='4';out[.’»]z'b';}; HL
if (zout==1) {out{0]="a";0ut[1]='0";0ut[2]='5";0ut[3]="b": }: //U.F
if (zout==2) {outf0]="a";out[1]='0";0ut[2]="6";0ut [B1=b'}: 7UB

}

if {yout==2)

{
if (zout==0) {out[0]="a";out[ 11="0";0ut[2]='T":0ut{3] ='h';}: /D
if (zout==1) {out[D]:'zl';out[1]:'D';out[2]='8';0ut[3]='b';}; HD

if (zout==2) {out|0}="a";,out[ 1]='0":0ut[2}="9";0ut[3]="b" }: /.13

f
if (xout==1)

|
Y

if (yout==0)
{
if (zout==0) {out[0]="a";0ut[1 = 150ut2]='0"0ut[3]="b" ) 41
if (zout==1) {out[0]="a";out[ 1)="1"0ut[2]="1":0ut[3]="b";}; /1..}
if (zovt==2) {outf0]="a";out{ t]='1";out[2]="2"0ut[3]="b";}; #]..B

3
§

if (yout==1)
{
il (zout==0) {out|N]="a";out[ 1]='1";0ut[2])="3";0ut[3]="b"}; /.1
if' (zout==1) {out[0]="a",out[1]='1";out[2]='4":0ut|3]="b"}; #L LI

il (zout==2) {out[0]="a",out[1]='1";0ut[2]='5"0ut[3]="b}: #/[..L .13
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i (yout==2)

]
t

il (zout==0) {owt[0}="a",out[ 1]='1;0ut[2}="6";0ut[3]="b";}; /1.1
il (zout==1) {out{0)="a"0ut[1]='1";0ut[2]="7"0ut[3]="b"}; #1 .10.F

if (zout==2) {out[0]="a";outf1]='1";0ut[2]='8"0ut{3]='b";}: #/1..D.B

}
if (xoul==2)

{

if (yout==0}

1
t

if (zout==0} {out[0]="a";out[1]="1"0w{2]='9";0ut[3]='b";}: /7R
it (zout==1) {out[0]="a";out[ 1]="2"0ut[2]='0"0ut[3]='b";}; #RJ
il (zouwt==2) {out[0]="a";out[ 1]="2";0ut[2]="1".0ut[3]='b";}; /R .1
}
if (yout—=1)
{
il (zout==0) {outf0]='a",0ut{1]="2";0ut[2]="2";0ut[3]="b";}; /R.L
if (zout==1) {out[0}="a";out[1]='2";0ut[2]='3"0ut[3]='b"}; /R L.}
if (zout==2) {out[0]="a";0ut[1]='2",0ut[2]="4" out[3]="b";}; /R.U.B
}
if (yout==2)
{
if (zout==0) {out[0]="a";out[ 1]='2";0ut[2]="5"0ut[3]='b" }: 7R,
il (zout==1) {out[0}="a";out[1]1="2";0ut[2]='6";0ut[3]='b5}; #R.D.I°

i {zout==2) {out[0]1="a"out[1]="2"0u1[2]="7";0ut[3]='b":}: #R.D.B

printf("pt.x = %d pty =%d cen.x =%d ceny = %d \n",pt.x,pt.y,cen.x,cen.y);

cvRectangle( img, ptl, pt2, CV_RGB(285,0,0),3,8,0);

cvRectangle{ img, pt, pt, CV_RGB(255,0.0}, 3, 8,0 ):



evRectangle( img, cen, cen, CV_RGB(255,0,0), 3, 8.0 );
print{("out = %s \n",out);

fSuccess=WriteFile(hCom,&out,4,&dwBytesWritten, NULL)

H

evShowlmage( "FTS", img )

evReleaselmage( &temp ),

gitdel EiC
main(1,"facedetect.c");

#endif

)
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#include < 161877.h>

#define TxID  PIN Cé6
#define RxD PIN_C7
ftdetine CLOCK SP 20000000
#fuses hs

#luses NOLVP, NOWDT
#tuses NOPROTECT

#use  delay(clock=20000000)
fluse  rs232(baud=9600, xmit=TxD, rcv=RxD)
Hbit cren=0x18.4
inti;

int8 k,pwml4],pw[3].control,controll,control2;
char datal41,strz;

void main{void)

{
set_tris_b(0x00),
set_tris d(0x00):

outpul_b{0x00} ;

for(k=0; k<=3; k++)

|
1

datallk] = 0
}
while(true)

{
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while(true)

cren={};

delay ms{(.01};

cren=1;
strz=getchi);

it (strz=="a")

break;
}

for(k=1; k<=3; k++)
{
data[0]="a";
data[k]=getch();
h

if (data[0]=="a"

pwill= data{1] ;
pw[2}= datal2] ;
pwi[i]=pw[l] - 0x30;

pwm[2]= pw{2] - 0x30;

i ((pwm[]==0)&(pwm[2]==1))

¥
4

output_b(0x00) ;

it (pwm[!]==0)&(pwm[2]==2))
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i
1

outpul_b(0x02) ;

if{(pwin[1]==0)&(pwm[2]==3))
{
output_b{Ux01) ;

1
s

if ((pwm[1]==0)&(pwm[2]==4))
{
output_b{0x20) ;
}
it ((pwm|1]==0)&(pwm[2]==5))
{
output b{0x22) ;
}
i (pwin[1]1==0)&(pwm[2]==6))
d

output. b(0x21) ;

;

it ((pwm[1]==0}&(pwin|2]==7))
{
output_b(0x10} ,

i
J

it ((pwml1]==0)&(pwm[2]==8))
{
cutput_b(0x12) ;

L
¥
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i ((pwm[1]==0)&(pwm[2]==9))
!
output_b(0x11) ;
'

i ((pwm[1]==1 Y& pwm[2]==0))
{

output_b(Ox0R8)

il ({(pwm[1]==1)&(pwm|2]==1))
{
output_b(0x0A) ;
'

it ((p‘w]n[ 1 ]== 1 )&(p\,\:]n[z]zzz))
{
output_b{0x09) :

}

i ((pwm[1]==1}&(pwm|[2]==3))
{
output_b(0x28) ;

!
{

ir ((pwm[1}==1)&(pwm[2]==4))
{
oulput b{0x2A) ;

}

{(pwm[1]==1D&(pwmn[2]==5))
1
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output_b(0x29) ;
}

it ((pwm[1]==1)&(pwm[2]==6))
{
output_b{0x18) ;

}

if ((pwm[1l==1)&(pwm[2]==7))
{
output_b(Ox1A) ;
}

if ((pwm(1]==1)&(pwm[2]==8))
{
output_b{0x19) ;
}

if ((pwml[1]==1)&(pwm[2]==9))
{
output_b(0x04) ;
!

if ((pwm[1]==2)&(pwm][2]==0))
{
output_b(0x06) ;

;

it ((pwm[1]==2)&{(pwm[2]==1))
{
output_b{Ox05) ;
h



it ((pwm[1]==2)&(pwm[2]==2))
{
output_b{0x24) ;
i

it ((pwm| 1]==2)&(pwm[2]==3))
{
output_bh{0x26) ;

}

i ((pwm[1]==2)&(pwm{2]==4))

I
1

output_b{(0x25) ;
;

if ((pwim| 1]==2)&(pwm[2]==5))
{
output_b{0x14):
}

if ((pwin! 1 ]==2)&(pwm[2]==6))

I
|

output =(0x16);

}

if {{(pwi|1|==2)&(pwm[2]==7))
f
autput bH{0x15) ;
}
} #this e ix for if loop

bithis one is for - ile loop
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Pin Diagrams {Cont{nued)
40.Pin PDIP
WetAver —t1 "/ 401~ RB7PGD
RAVANY -—e[]3 38 [) -=—s RB5
RAZ/ANZVREF JCVREF amns [ 4 37 [)-=— RB4
RAVANINREF+ w—[] 5 36 [1 = RBUPGM
AATOCKHTAOUT w—w [ 6 35 H) e RB2
RASIANABSIC20UT w—= ] 7 ﬁ 3 [] -~ RB1
REO/RDIANS =[] 8 i~ 13} e— RBOINT
RE1WEANG =19 g 32 ) «— voo
RE2CSIANT =[] 10 31 [] e V55
Voo —a 11 % 30[«— RD7TPSPT
Vs —o (112 5 28[)e— RDGPSPE
OSCUCLKl ——w [}13 T 28]+ RDSPSP5
OSCHCLKO +— 14 £ 27 [1o—e RDPSPA 'y
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ACICCP ——a[) 17 24 [} wemw RCSE00 N
RCYSCK/SCL =[] 18 73 []»—= RCA/SDUSDA §§w g gu
RDONPSPO ——e [ 18 23 I e RDWPSP3 E_Eé e
ADAPSPT e [} 20 21 o= RDZPSPZ 335315 SEE@%E
a4PinPLEC L L
; moy
RALTOCKICIOUT o e ~—= REYPGM
RAVANASSCZOUT ou ~—~ FB2
REG/RAD/ANS o [] w—e RB1
YL p—. = ABOINT
REZCSIAN? = ! PIC16F874A - Yoo
— -—
ves (12 PICI6FE77A = RD7PSPT
OSCUCLK] —e[] 14 ——w RODBPSPS
OSC2CLKO -—— [ 15 ~—w RDSPSPS
RCOM1OSOMICK] == []1g ~— RDAPSF4
NC T <98 = RCTIRXIDT
§ oo
SR L
LolRaseRis
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REP0PEREY BEdEEEEIRxy
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- FrXEEZ 0 P2
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vss ~—=LCIli8 ~— Voo ___
voo —LCID 7 PICA6F3TIA 271} w—= REZ/CS/AN7
RBWNT =—+CIT 8 2610w REWFIANG
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L298

DUAL FULL-BRIDGE DRIVER

» OPERATING SUPPLY VOLTAGE UP TO 46 V

+ TOTAL OC CURRENT UP TO 4 A

s LOW SATURATION VOLTAGE

» OVERTEMPERATURE PROTECTION

s LOGICAL "0" INPUT VOLTAGE UP TO 15V
(HIGH NOISE IMMUNITY)

DESCRIPTION

The L298 is an intagratad mondlithic citouitin a 15-
jaad Multiwatt and PowerS020 packages. |t is a
high voltage, high current dual full-bridge driver da-
signed to accept standard TTL logic lavels and drive
inductive [oads such as relays, solenaids, DC and
stepping motors. Two enabla inputs are provided to
anableor disabla the device indepandently of the in-
put signals. The emitters of the lower fransistors of
aach bridge are connected togethar and the comwe-
sponding externat terminal can be used for the con-

BLOCK DIAGRAM

S

==

Multiwatt15 PowerS020

RDERING NUMBERS ; L298N (Multiwatt Vert.)
L298HN (Multiwatl Horiz. )
L298P (PowerS020)

nection of anexternal sensing resistor. An additional
supply input is provided so that the logic works at a
lower voltage.

Jenuary 2000

ouy ours oura outs
("pl (l') AWOnF
2 3 % 0 M
1?353_ L et N .
oo ‘
= e -CI2 D (1o
1 2 3 4
5 bl 2
4
Ind Lny
o—4- vl o
%A » " B
1 Y " -0
SENSE AO——4 ) _L $—osasen
LIy g‘&l
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1.294
ABSOLUTE MAXIMUM RATINGS
Symbaol Paramester Valua Unit
Va Power Supply 50 v
Vs Lonic Supply Voltage 7 v
VI, Van Input and Enable Voltage ~0.3t07 v
o Pagk Cutput Curent {each Channel)
~ Non Repetitive (t = 100us) 3 A
~Repeitive {(80% on ~20% off, 1.0 = 10ms) 256 A
~O . Cperation 2 A
Maors Sensing Volege -1 1023 v
Prat Total Power Dissipation (Tems = 75°C} 25 W
Top Jungtion Operating Temperaiure —25 t0 130 °C
Teg. T} Storage and Junclion Temperaluie -40 10 150 G
PiN CONNMECTIONS {iocp view)
i (L1 Re— CURRENT SENSING B
W [T ouTPUT 4
$‘ 13T outputs
12 20 INPUT 4
(R1 tom——— ENABLE B
10 [T TS
. 9 LOGIC BIPPLY VOLTAGE Vg
Puttlwattw a % GND
7 E__)D INPUT 2
Y au— ENABLE A
s /2 INPUT 1
4 [T SURPLY VOLTAGE Vs
@ LI ouTPUT 2
2 TS ouTRuT Y
I S CURRENT SENSING A
TAP EONNELCTED TO PIN S LRISMMOA
GND E:jr1 20 GND
Sense p 2 19 | ] Sensed
N.C. 3 18 ] NC.
ont 7] 4 7 b Out 4
2 (s Power8O2 g | Qui 3
Vg 5 G 15 Input 4
gt 4 L 7 44 E Ensne®
Enabia A g 8 13 | Input 3
put 2 | o 2 o) vss
GhND [ 10 1 |23 6ND
DYINIE
THERMAL DATA
Symbol Parameter Power$020 Multiwatt15 | Unit
Rinjeme | Thermal Resistance Jundlion-case Max, - 3 oG
Rinjame | Thermal Resistance Jundion-ambient Max. 13 (Y 35 “CIW

{") Mounied on allsminuin suberata
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Featuring Unitrode 1293 and L2930
Products Now From Texas Instruments
Wide Supply-Voltage Range: 4.5V to 36 V
Saparata tnput-Logic Supply
Internal ESD Protection
Tharnai Shutdown
High-Noise-tmmunity inputs
Functionally Similar to SG5 L293 and
5G5S L293D
Output Current 1 A Per Channel
(600 mA for L293D)

Peak Output Currant 2 A Par Channe!
{1.2 A for L293D)

Output Clamp Diodes for Inductive
Transient Suppression {L293D)

cription/ordering information

The L2893 and L293D are quadruple high-current
half-H drivers. The L293 is designed io provide
bidirectional drive currents of up 1o 1 A al voltages
from 4.5 ¥ 1o 36 V. The L2930 is designed to
nrovide bidirectional drive currents of up to
600-mA at vollages from 4.5 V to 36 V. Beth
devices are designed to drive inductive lpads such
as relays, solenoids, dc and bipolar stepping
molors, as wall as other high-current’high-voitage
loads in positive-supply applications.

Ail inputs are TTL compatible. Each output is a
complete lotem-pole drive circuit, with a
Darlington  transistor sink and a pseudo-
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1.293, L293D

QUADRUPLE HALF-H DRIVERS

SLRS00BC ~ SETEMBER 1986 ~ REVISED NOVEMBER 2004

L2583 ... N OR NE PACKAGE
L293D... NE PACKAGE

{TOP VIEW)
1,26N ff 4 \'T*B Voot
1A {]2 15} 4A
1Y fi3 14}] 4Y
HEAT SINKAND S~ {[¢  13[] } HEAT SINK AND
GROUND { {{s  12]} ( GROUND
2Y {{a 1 %:w
2a{l7  1oflaa
Veca J8 sftadEN
L293 ... DWP PACKAGE
{TOP VIEW)
1,2EN ] Voot
1A[] ah
1y 4y
NC NC
NC NC
NC NC
HEAT SINK AND l’ \l HEAT SINK AND
GROUND <l r GROUND
N ] NC
NC ] NC
2Y 3y
24 3A
VCC2[; J4EN

Larlington source. Drivers are enabled in pairs, wilh drivers 1 and 2 enabled by 1,2EN and drivers 3 and 4
enabled by 3,4EN. When an enable input is high, the associated drivers are enabled, and their outputs are aclive
and in phase with their inputs. When the enable input is low, those drivers are disabled, and their outputs are
off and in the high-impedance state. With the proper data inputs, each pair of drivers forms a full-H {or hridge)
reversible drive suilable for solenocid or motor applications.

ORDERING INFORMATION

ORDERABLE TOP-SIDE
A PACKAGET PART NUMBER MARKING
HSOP (OWP) Tuba ol 20 |L293DwWP L203DWP
PO (N) Tubs of 26 IL293N L263N
C to 70°C
- Tabe of 35 | L293NE (299NE
! (NE) Tube of 25 L2030NE L293IDNE

o
1RO

Prouise e 2001918 & apecificatirit par e betms of Tedae Jadrusy e
£hnded warratdy. ¥reuelion [0 RRIng By R0l PERASAAAK ML
nstng A Al o2l Krotets.

FPackage drawings, standard packing gquantities, thermal data, symbolization, and PCB design guidelines are available at

rowrw ti comiseipackage.

CUGH DATA irfmnatinn f cuarord as of publeadion dofe.
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Pleass be aware that an impartant notice concerning availability, standard warranty, and use in critical applications of
Texas Instrumenis semiconductor producis and disclaimers thereto appears at the end of this data sheat,
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1293, L.293D : 8o
QUADHUPLE HALF-H DRIVERS

SL.R5008C - SEPTEMEER 1986 — KEVISED NOVEMBER 2004

description/ordering information (continued)
On the L293, external high-speed output clamp diodes shaould he used for inductive transient suppression.
A Ve lerminal, separate from Veep, 1s provided for the logic inputs to minimize device power dissipation.
The L293and L 293D are characterized for operation from 0°C ta 70°C.

Hock diagram

{
l:f"r*l 18 Ii-—-j

|
!.n:;

- |
14 |

1
12 IL__l

11

S ]
9

| e e e e o e e 0

o
N
-
o

NOTE: Odtput diptes are internal in L293D.

FUNCTION TABLE
(each driver)
INPUTST OUTPUT
A EN Y
H H H
L H L
X L z

H = high lavel, L = low leval, X = irrelevant,

Z = high impadance {ofT}

tin the thermal shutdown mode, the putput is
in the high-impedance state, megardiess of
the input lavels.

‘*9 TEXAS
INSTRUMENTS

2 POST OFFICE BOX 655303 ® DALLAS, TEXAR 75285
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1253, 12930
QUADRUPLE HALF-H DRIVERS

SLRS002C - SEPTEMBER 1986 - REVISED NOVEMBER 2004

schematics of inputs and outputs {L293D)

EQUIVALENT OF EACH INPUT TYPICAL OF ALL QUTPUTS
- Veez
Yeed g e
Current l
Source
e
Input - T""-"—- Quiput
ND S
—— GND

absolute maximum ratings over operating free-air temperature range {unless otherwise noted)t

Supply voltage, Ve (8ee Note 1) . oo 3BV
Ut SURPlY vORage, VoD e 36V
InpUL vORAge, M| i e TV
Oulput vollage range, Vs ..o e -3VioVopo+3V
Peak output current, Iy (nonrepetitive, t <S5ms): L293 ... ... 2 A
Peak putput current, ley {nonrepetitive, t <100 ps): L293D ... .. ... ... t1.2A
Continuous output current, lo: L2893 i 1A
Continuous owtput current, Ipy: L293D o +600 mA
Package thermal impedance, 65 (see Notes2 and 3). DWPpackage ....................... TBDC/W

Npackage ............................ 67°C/IW

NEpackage ......................... TBDC/W
Maximum junction temperature, T ... e, 160°C
Storage temperature range, Tgpy ... e ~-85°C to 160°C

T Slresses beyond those listad under “absohiie maximum ralings” may cause pamnanent damage 1o the device, These are stress ratings only, and
functional operation of the device at these or any other conditions beyond those indicated under "recommended operating conaltions" is not
implied . Expasure ta absolute-maximum-rated conditions for exiended perlods may affect device refiabitity.

NOTES: 1. Allvoftage values are with respect to the network ground terminal.

2. Maximum power dissipation is a functian of T y(max), fja, and Ta. The maximum aliowable power disgipation at any allowable
ainbiert lemperature is P = (T J(max) - T4¥6 A, Operating at the absolute maximum T j of 150°C can affect reliability.
3. The package thermal impedance is calculated in accordanca with JESD 51-7.

‘&9 TEXAS
INSTRUMENTS

4 o06T OFFICE NOX 855303 ® DALLAS, TEXAS 75265
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1293, L293D
QUADRUPLE HALF-H DRIVERS

SLROPTEMEIER 1986 - REVISED NOVEMBER 2004

recommended operating conditions

MIN  MAX | UNIT
v 4.5 7
Supply vollage : ee! v
vces Vees 38
Vop1£7V 23 Voo v
v Highdevat input voltag
1H ighdeva! input voltage Voot 2TV 53 7 v
vIL  Low-level output vollage ~pat 15 v
Ta, Operating fres-air temperature 0 70 °C

T The alyebraie convention, in which the least positiva (most negative) designated mirimum, is usad in this data sheet for logic voltage jevals.

electrical characteristics, Voc1 =5 V, Vecz = 24 V, T = 25°C

PARAMETER TEST CONDITIONS MIN TYP MWAX | UNIT
VoM High-tevel outpul voltage tgg;D II%}:;-JD; A Veoe—18 Veooz-14 A
Vo Law-level oulput voltage tggng%LLi 10'; A 1.2 18 v
VoK High-eyel oulpu clamp vollage L2933 Ipk = ~06 A Voo +13 v
VorL  Low-evel output damp voltage L293D: lnK = 0.6 A 1.3 v
] . A ) 0.2  t00
Imln.{ High-eval input currant P V=7V 02 0 LA
A -3 ~10
e Low-level input current EN Vi=0Q =300 WA
Al outputs at high level 13 22
e Logic supply current ln=0 All cutputs at low level a5 601 mA
All outputs at high impedanca 8 24
- All outputs at high tevel 14 24
lces Output supply currerd In=0 All autputs at low level § mA
All outputs at high impedance 4
switching characteristics, Vooq =5 V, Veg2 =24V, Ty = 25°C
L2B3INE, L292DNE
PARAMETER TEST CONDITIONS MIN_ TYP  MAX UNIT
ipLH  Propagation delay tima, low-to-high-lsvel output from A input 800 ns
iprL  Propagation delay time, high-todow-lavel output from A input CL =30 pf, Ses Figurs 1 400 ns
typH  Transition fime, low-io-high-eval output 300 ns
tryr,  Transition time, high-to-low-leval output 300 ns
switching characteristics, Vgg1 =5V, Vo2 =24 V, Ta = 25°C
L293DWP, L293N
PARAMETER TEST CONDITIONS L2830N UNIT
MIN  TYP MAX
fpLH Prapagation delay time, low-to-high-level oulput from A input 750 ns
ipyL  Propagation delay time, high-tadow-level autput fram A input CL=30 pF, Ses Figure 1 200 ns
iTLH  Transition time, low-to-high-4eval output 100 ns
tryL Transition time, hgh-to-dowdevel output 350 ns

“? TEXAS
INSTRUMENTS

POST OFFICE BOX BS5303 ® DALLAS, TEXAS 75285 5
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MAX232, MAX232|
DUAL ElA-232 DRIVER/RECEIVER

SLLE(MTG - FEBRUARY 1889 - REVISED AUGUST 1598
. -

Operates With Single 5V Power Supply D, DW, OR N PACKAGE
LinBiCMOS™ Procesa Tachnology (TOP VIEW)

]
&
) i i . |
Two Drivers and Two Receivers ci+ 11 ] Vee
& +30-V Input Levels Ve [l 2 GND
® Low Supply Current ... 8 mA Typical Ci1-i]3 TiOUT
8  Moets or Exceads TIA/EIA-232-F and ITU c2+fle % R1IN
Recommandation V.28 C2-[} s R10OUT
& Designed to be Interchangeable With Vs- 1l 6 ) T1IN
Maxim MAX232 T20UT I} 7 T2N
C e R2IN |} 8 R20UT
& Applications
TIA/EIA-232-F lodi bolt
Battery-Powered Systems ogic symho
Terminals vee
Modams * 18
Computers ] Voo
® ESD Protection Exceeds 2000 V Per Cis — %] C1» 2
MiL-STD-883, Mathod 3015 c1e 2 ei.  Meg-18V [—F Vse
® Package Options Include Plastic c2+ A e €2+ _zvec+1.6V I Vg
Smati-Outline {D, DW) Packages and c2- ~—t— ca.
Standard Plastic {N) DIPs
. TN > " riour
description
10 > S
The MAX232 device is a dual driver/receiver that T2ZIN T20UT
includes a capacitive voltage generator 1o supply L 7l N
EIA-232 voltage levels from a single 5-V supply.
Each receiver converts EIA-232 inpuls to 6V RIOUT —e] oV Il et R2IN
[TLICMOS levels. These receivers have a typical
threshold of 1.3 V and atypicai hysteresisof 0.6V, * 15
and can accept *30-V inpuls. Each driver GND

canverts TTL/CMOS input levels inta EIA-232 T This symbol is in accordance with ANSVEEE Std 91-1584 and IEC
levels. The driver, receiver, and voltage-generator Publication 67-12.

functions are available as celis in the Texas

Instruments LinASIC™ library.

The MAX232 is characterized for operation from
01"C to 70°C. The MAX232t is characierized for
operation rom ~-40°C to 85°C.

AVAILABLE OPTIONS

PACKAGED DEVICES
SMALL SMALL
Ta OUTLINE GUTLINE PLAS(L';: o
) (DW)
°C to 70°C MAX232DY MAX232DWE MAX232N
~40°C 1o 86°C MAX232(D% MAX232IDWE MAX232IN

T This device is available taped and reeled by adding an R to the part number (i.e., MAX2320DR).

Please be aware that an imporiant notice concerning availability, standard warranty, and use in critical applications of
Texas instruments semiconducler products and disclaimers thersto appsars at the end of this data sheet,

LinASIC and LinBiCMOS are trademarks of Texas Instruments InoorEratad.

PROGUCTION DATA imdorealoe & curvert as d{h feation. dse. GCopyrght @ 1398, Taxas Inslniments lncorpomtad
Prodixts canfars to speciinaony per Iflm:-! of Texm h;ru-tr'l: b

standerd warenly, Profuclion pioces. 3 el necesEANly incl

L4 nngulallpa'ﬂ{llﬂtls processing TEXAS

POST (JI'FICE BOX 655303 ® DALLAS, TENAS 75285 1




MAX232, MAX232]
DUAL EN-232 DRIVER/RECEIVER

SLLEO4YG ~ FEBRUARY 1888 - REVISED AUGUST 1998

92

absolule maximum ratings over operating free-air temperature range (uniess otherwise noted)t

Input supply valtage range, Ve {see Note 1) ..o . o . ...

Fasilive output supply voltage range, Vg4
Negative ouput supply voltage range, Vg_
fnput vollage range, V|: Driver

-03VioBV
Vee-03Vio 15V
-03Vio-15V
-03VioVec +03V

R CRIVET . +30 VvV

Cutput voltage range, Vo: T10OUT, T20UT

R10UT, R20UT
shorl-circuit duration: T1OUT, T20UT
Package thermal impedance, 0,4 (see Nate 2): D package

Storage temperature range, Tgy
Load temperalure 1,6 mm (171G inch) from case for 10 seconds

DWpackage ... ... ........
Npackage .................

Vg_~03VioVg. +0.3YV
-03Via Voo +03V
Unlimited
113°Cvy
105°Crw
78°C/W
~65°C to 150°C
260°C

T Sresses beyord those listed under "absoluta meximum ratings’ may cause permaneni darmnage to ihe devica. These are stress ratings only, anc
furiclirral vperation of the device at these or any other conditions beyond these indicated under “recommended operating conditions® is not

itnpliad. Exposurs to absolste-maximum-rated conditions for exiendet perinds may affect devics reliability.

NOTE 1. All voltage valuss are with respect to network ground terminai.
7

of zero.

recommended operating conditions

2. Thepackage thermalimpedanca is calculated In accordance with JE SD 51, excepl for through -hole packages, which usa a traca langih

MIN NOM MAX| UNIT
Supply voltags. Vg 4.5 5 6.5 v
High+evel input voltage, Vi (T1IN,T2IN} 2 v
Lowdsvel input voltage, V|t {T1IN, T2IN) 0.8 v
Receiver inpul vollage, R1IN, R2IN 130 Y
Gparating free-air temparature Ty Maxa32 0 9 °C
MAX232i —40 a5

{’? TEXAS
INSTRUMENTS

2 FOST OFFICE BOX B55303 ® DALLAS, TEXAS 75265




SLLS047G - FEBRUARY 1989 - REVISED AUGUST 1338
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MAX232, MAX232
DUAL £VA-232 DRIVER/RECEIVER

electrical characteristics over recommended ranges of supply voltage and operating free-air

temperature range {uniess otherwise noted)

| PARAMETER TEST CONDITIONS MIN TYPt MAX | UNIT
. T10OUT, T20UT R = 3 k2 to GND 5 7

Viy+q  High-evel outpul voltage \4
- R1OUT, R20UT |IgH =-1mA 35

VoL Low-level output voitage® T1OUT T20UT 1Ry = 3ka2to GRO i = v

R10UT, R20UT iQ|== 3.2 mA 04

VT fﬁ:‘;‘:’;&‘;‘;ﬁﬂ;gg“'"g input R1IN, R2IN Ve =6V, T = 25°G 17 24| v
vIT- E':;f,',ﬁ;i‘,’,ﬁzg‘:‘"m"g rput R1IN, R2IN Ve =5V, Tp = 25°C 08 12 v
Vhys  Input hysteresis voitage R1IN, R2IN Vec =358V 0.2 05 1 '
I Receiver input resistance R1IN, R2IN Voo =6, Ta = 25°C 3 7 k2
ra Outpui resistance T10OUT, T20UT V; =Vg_=0, Vp=12V 00 9]
ios®  Shor-drcuit cutput curent TIOUT, T20UT [Vog =556V, V=0 £10 mA
hs Short-circuil input current T1iN, T2IN Vi=0 200 uA
i Supply curment ¥EE ; 5502 v. Al outputs open, 8 101 ma

I Al typical values are at Voo = 5V, Ta = 26°C.
FThe algebraic corvention, in which the Jeast positive {(mast negative) value is designated minimum, is used In this dala sheet forlogic voitage

levrls onty.
& Nolmars than one outpul should be shorted at a time.

swilching characteristics, Voo =5 V, Ta = 25°C

PARAMETER TEST CONDITIONS MIN TYP MAX | UNT
IpH(R) Receiver propagation delay time, low- o highJevel output See Figure 1 500 ns
1ML (R) Receiver propagation delay time, high- to low-evel output See Figure 1 500 ns
. . R = 3kftio 7 kL
iAS Driver slow rale See Figure 2 30| vas
BRIt} Driver transition region slew rate Soe Figura 3 3 Vs
| )

‘t’f TEXAS
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